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Table Conversions Overview 

Table conversions are a type of batch process. They allow you to do high-speed manipulation 
of data in tables. The table conversion tool includes the following four conversion types, 
which allow you to manipulate data in a variety of ways:  

• Data Conversion allows you to transfer or copy data from an input table or business 
view into one or more output tables using any amount of logic necessary to perform 
the transfer. You also can use Data Conversion to update records in a table or 
business view.  

• Data Copy allows you to copy one or more tables from one data source or 
environment to another data source or environment.  

• Data Copy with Table Input allows you to copy tables based on information from an 
input table. For example, the input table might provide information about which tables 
should be copied, where they should be copied to, and so on.  

• Batch Delete allows you to delete records from a table or business view. 

The table conversion tool can use any J.D. Edwards software tables, business views, and 
text files, or any tables that are not J.D. Edwards software tables but reside in a database 
supported by J.D. Edwards software, such as Oracle, Access, AS/400, or SQL Server. These 
non-J.D. Edwards software tables are referred to as foreign tables.  

When you create a table conversion, you set up the conversion (which can be saved and run 
multiple times), review it, and then run it. If necessary, you can test the conversion by running 
it in proof mode.  

Like reports, table conversions consist of a template and one or more versions. You can 
override certain properties within a version at run time.  

The table conversion tool allows you to access any available environment for both input and 
output. The environments that you choose determine which tables and business views are 
available for the conversion and where the tables reside. The environments that you choose 
also determine the specification, or description, of tables and business views. 

1 



Types of Tables You Can Convert 

You can use the following table types in table conversion:  

Standard 
J.D. Edwards 
software tables 

These tables exist in Object Librarian, and you design and edit them using 
Table Design Aid. At design time, only the specification is needed to reference 
the table. At run time, the table must be generated. An instance of the table 
must be made in a specific database.  

Non-J.D. Edwards 
software (foreign) 
tables 

These tables do not have a J.D. Edwards software definition, but they reside in 
a database supported by J.D. Edwards software at design time and run time. 
You must set up a data source and environment in J.D. Edwards software to 
point to the location of a non-J.D. Edwards software table. 

 

See Also 
� Preparing Non-J.D. Edwards Software Tables for Table Conversion in the Table 

Conversion Guide 
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Using Business Views in Table Conversion 

If you transfer data from multiple tables to a single table or if you transfer data from multiple 
tables to multiple other tables, you must establish a relationship between the input tables by 
defining a business view. A business view defines the relationship between two or more 
tables, and the data is joined into what looks like a single table. You can use J.D. Edwards 
software business views only for input to the table conversion, not for output. The system 
does not provide direct support for joining foreign tables. If you need to use multiple non-
J.D. Edwards software tables as input to a conversion, you must first define them through 
J.D. Edwards software, and then create a business view for them. 
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Using Text Files in Table Conversion 

You can import directly from or export directly to a text file. When you convert a text file, it is 
stored with a single, long text field (similarly to a foreign table). User-defined formats are 
stored the same for a text file as for any table. With a text file conversion, the table name 
includes the path and the file name. If you do not specify the path with the file name, the 
default path will be used.  

4 



Using Sort and Selection Criteria in Table Conversion 

You can specify sort criteria in a table conversion to process input rows in a sequence that 
groups related records together. The table conversion tool allows you to add logic to the point 
at which a change occurs to the value in a field. The sort and selection features simplify the 
process of writing records to multiple tables in a typical one-to-many conversion. For 
example, if you have a table of customer information, you could sort the table by area code 
and split the single table into tables for each area code. Similarly, you could specify selection 
criteria for the input table if you want to convert only a subset of that table.  
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Understanding Input and Output Environments 

An environment consists of a path code and one or more Object Configuration Management 
(OCM) mapping records that indicate where various J.D. Edwards software objects reside. 
The table conversion tool allows you to specify an input and output environment, and it uses 
the environments that you specify to locate input and output tables. To locate non-J.D. 
Edwards software tables, the table conversion tool uses the default OCM mapping records 
for tables.  

The path code of the environment is used to locate specification files for the environment. 
This path code is usually a subdirectory under the J.D. Edwards software directory on your 
workstation. To reference J.D. Edwards software tables in an environment, the full path code 
must exist on the machines where the conversion is designed and runs. Non-J.D. Edwards 
software tables can be referenced even if the path code does not exist. 

The table conversion tool uses the following three environments when it processes a 
conversion:  

• The environment that you are signed into  

• The environment for the input tables  

• The environment for the output tables  

The environment that you are logged on to determines where the table conversion 
specifications are stored. You can choose an environment for your input table or view, and 
one for your converted output tables. All three environments could be the same or all three 
could be different. 

When you use J.D. Edwards software tables or views in a conversion, the environment 
provides the details of each table or view, such as the column names, data types, and 
descriptions. Because this information comes from the J.D. Edwards software specification 
tables, the J.D. Edwards software table or view does not have to exist in the database for you 
to design a conversion; but it needs to be created before the conversion is run. If you use a 
non-J.D. Edwards software table as input, you need to create the foreign table before you 
design the conversion because the tool gets its information about the table directly from the 
database containing the non-J.D. Edwards software table. The environment also provides a 
default path for text files.  

See Also  
� Table Design in the Development Tools Guide for more information about creating 

standard J.D. Edwards software tables 

� Preparing Non-J.D. Edwards Software Tables for Table Conversion in the Table 
Conversion Guide for more information about using non-J.D. Edwards software 
tables as input to a conversion 

� Data Sources, Path Code Setup, and Environment Setup in the Configurable 
Network Computing Implementation Guide for more information about data sources, 
path codes, and environments 
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Setting Up a Table Conversion  

You use a Director to set up a table conversion. The Director guides you through the process 
and allows you to modify the table conversion at each point. Using the Director, you can 
design table conversions for converting data, copying tables between locations, and deleting 
records within tables.  

You also can define user-defined formats (flat files) to use in the table conversion. You define 
these formats when you choose your input or output tables. User-defined formats are tables 
that store data as one continuous string of information, such as bank tapes.  

After you set up a table conversion, you can save it and run it multiple times. 

See Also 
� User-Defined Formats in the Table Conversion Guide 

Before You Begin 
� If you are importing data from non-J.D. Edwards software tables, you must set up a 

data source and environment for those tables. For more information, see Preparing 
Non-J.D. Edwards Software Tables for Table Conversion in the Table Conversion 
Guide. 

� If you are mapping from multiple tables, you must create a joined business view for 
the tables. For more information, see Creating a Table Join in the Development Tools 
Guide. 

� If you want to validate the data items within a table against the data dictionary as part 
of the conversion process, you must create a business function to perform the 
validation. The table conversion tool does not provide automatic data dictionary 
validation for inputs or outputs. See Business Functions in the Development Tools 
Guide for more information about creating business functions. 
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The Flow of Events in Table Conversion  

When a table conversion is processed, the system triggers events that are similar to the 
events that are triggered when a report or application is run. These events are specific to the 
table conversion that you set up, and they provide points where you can add logic to the 
conversion.  

In general, the event flow is the same for all table conversion types (Copy Data, Copy Data 
with Table Input, Batch Delete) because these conversion types are subsets of a data 
conversion. For example, the Data Copy conversion type does not include input and output 
tables, and all actions are accomplished through the Process Begin event. The Data Copy 
with Table Input and Batch Delete conversion types do not include output tables and all 
actions are accomplished through the Process Begin, Process End, and Row Fetched 
events. This flexibility allows you to mix and match table conversion types within another 
conversion type, if necessary.  
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The following graphic shows all events that can be triggered in a conversion. Depending on 
the type of conversion that you set up, some events might not be triggered. In the graphic, 
events are shown as a yes or no decision.  
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Events in table conversion occur in the following order:  

Process 
Begin  

Before fetching records from the input table, the system invokes the Process Begin event. 
At this point, you can attach any logic that processes only once at the beginning of a 
conversion, or any other value that does not change for each individual record. This event 
is useful for mapping output fields that do not change for each record.  

Data 
Changed  

If you use data sequencing, the system invokes a Data Changed event for any 
sequenced field that changed. Data Changed events are not cascaded or hierarchical. 
For example, you can attach an event rule to this event if you want to total a field or group 
of values.  

Format 
Fetched  

If you use user-defined formats (also known as flat files) in the input table, the system 
invokes a Format Fetched event for each record fetched from the input table. If you use 
multiple user-defined formats in a conversion, the Format Fetched event that is called will 
correspond to the format found in the record.  

Row 
Fetched  

An input table invokes a Row Fetched event after each row is fetched from the input 
table.  

Process 
End  

After all records have been processed, the system invokes the Process End event. You 
attach event rules to Process End when you want the system to process logic after all 
input records have been read; for example, to write a total record to an output table or to 
write a record to a log file to record the status of the conversion.  
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Using the Table Conversion Director  

The Table Conversion Director guides you through the process of setting up a table 
conversion. The Navigation Assistant, which appears within the Director, provides a visual 
reminder of where you are throughout the setup process. You also can use the Navigation 
Assistant to move to a different step in the process by clicking any step listed in the Assistant. 

 

► To use the Table Conversion Director 

From the Cross Application Development Tools menu (GH902), choose Object 
Management Workbench.  

1. Click Find.  

2. Click the project to which the new batch process will be added, and then click Add.  

3. On Add J.D. Edwards Object to the Project, choose Batch Application and click OK.  

4. On Add Object, complete the following fields:  

• Object Name 

• Description 

• Product Code 

• Product System Code 

• Object Use 

5. Turn on the Table Conversion option, and then click OK.  

6. On Batch Application Design, click the Design Tools tab and then click Start Table 
Conversion Design Aid.  

The system displays the Introduction form for the Table Conversion Director. 
Depending on the conversion you want to perform, follow the steps that are 
described in the following topics in this guide:  

• Data Conversion 

• Data Copy 

• Data Copy with Table Input 

• Batch Delete 
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Data Conversion 

You use the Data Conversion option on the Table Conversion Director when you want to 
move data to one or more tables from:  

• A single table  

• Multiple tables defined in a business view  

• A single text file  

The Director leads you through a process for creating a data conversion batch application by 
asking questions about its structure and function. When you are finished, you can review and 
alter the conversion, if necessary.  

Before You Begin  
� Create a batch application object. See Using the Table Conversion Director in the 

Table Conversion Guide for information about starting the data conversion design 
process and the Director. The last step launches the Director.  

 

► To define external data  

1. On the Introduction form of the Table Conversion Director, click the Data Conversion 
option and then click Next. 

2. On the External Data form, click Select to attach a predefined processing option 
template to the table conversion.  

3. On the Select Processing Option Template form, choose the processing option that 
you want to use and then click OK to return to the External Data form.  

4. If you want to attach data structures, click Define. 

5. On the Report Data Structure form, define the data structures that you want to attach 
to the table conversion, and then click OK to return to the External Data Form. 

Data structures contain a list of parameters that can be used to pass data into the 
conversion when called through Report Interconnect.  

6. Click Next.  

See Also 
� Data Structures in the Development Tools Guide 
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► To define input and output environments  

1. On the Select Environments form, choose the input and output environments that you 
want to use. 

Note 
Choose <LOGIN ENV> if you are creating a table conversion on your workstation 
that will be shipped to a client who does not have the environments that you have. 
The table conversion will use the client login environment. 

 

2. If you are creating a table conversion that will run in a different environment than the 
one in which you are creating it and the <LOGIN ENV> is not appropriate for the type 
of conversion that you are creating, click the Force Version to Override Input 
Environment option or the Force Version to Override Output Environment option. 

For example, if you create a conversion that will be shipped to a client who does not 
have the environments that you have, you would turn on these options. When the 
conversion is invoked at the client site, the system will not run the conversion until the 
user chooses an appropriate environment in which to run it.  

3. Click Next.  

 

► To define input  

1. On the Select Input form, click the appropriate tab based on whether your input is a 
table, a business view, a foreign table, or a text file. 

2. If your input is a table or a business view, drag it to the Description pane.  

If you know the name of the table or business view that you want to use, enter the 
name in the Object Name field in the QBE (query by example) line and press Enter.   

You can choose only one table or one business view per conversion. If your input 
consists of multiple tables, you must create a single, joined business view. 

3. If your input is a text file, on the Text File tab, type the name of the file and click Use 
or click Browse and then open the appropriate text file. 

Notes 
For the AS/400®, input text files are stored in the integrated file system (IFS). Enter 
the path to the IFS before the file name. 

If you change a table, business view, or text file, the system warns you that deleting 
tables removes all mappings from the table conversion. Click OK. 

If you are using a text file or if you need to define a format for a table or business 
view, click the User Defined Format option and follow the steps described in 
Importing and Exporting Text Files in the Table Conversion Guide.  
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4. To delete an input name, choose it and press Delete.  

5. Click Next.  

6. On the Sequencing form, click Data Sequencing to define data sequencing for a table 
or business view. 

If you specify a text file for input, you cannot define data sequencing or selection for 
that file.  

Note 
When you define data sequencing, you create new events that are available to you in 
the Mapping section of the Director. One new event is created for each sequence 
column that you define. The event is called XXXX Data Changed, where XXXX is the 
column alias—for example, ALPH Data Changed. Each time the value in one of 
these columns changes from its previous value, the column's Data Changed event is 
invoked. This event is similar to a level break in report writing, except that the Data 
Changed events are not related to each other. Invoking one does not invoke the 
others. 

 

7.  Click Next.  

The Data Selection form appears.  

Note 
You can only define selection criteria over database table columns. User-defined 
format columns are not available because they do not exist in the database. 

 
On the Data Selection form, Where is the default value in the Operator column for the 
first set of criteria. For subsequent statements, And and Or become the available 
values for the Operator column and are chosen by double-clicking the appropriate 
word.  

8. Click the Left operand field to display the list of available objects, and then do one of 
the following:  

• Scroll through the list until you find the desired object, choose the object, and 
then double-click the object to populate the Left operand column.  

• Type the first letters of the object name in the Left operand field to find the object 
in the list, and then double-click the highlighted object.  

When you double-click the object for the Left operand column, the list of available 
values for the Comparison column appears.  

9. Choose one of the following comparison operators:  

• is equal to  

• is equal to or empty 

• is greater than  

• is greater than or equal to  
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• is less than  

• is less than or equal to  

• is not equal to  

10. Click in the Right operand column to display a list of available objects, special values, 
or variables. 

Your choices in this column depend on the choice that you made in the Comparison 
column. Some of the following options might be available: 

Blank  Enters a blank (space) value.  

Literal  Enter specific values (see the following step for information about entering specific values).  

Null  Indicates that no value is associated with the field.  

Zero  Enters a value of zero.  

IC  Indicates an input table column.  

RI  Indicates a value passed through report interconnections to this table conversion.  

PO  Indicates a processing options value for this report.  

SL  Indicates a system literal.  

11. If you chose to enter a literal in the Right operand column, the Single value form 
opens and you can enter values on the following tabs:  

• Single value 

Enter a single value, and then click OK. For example, a value might be for a 
particular company.  

• Range of values 

Enter a range of values, and then click OK. For example, a range of values might 
include companies from 00001 to 00060. When using a range of values, only the 
following two logical operators are valid: is equal to and is not equal to.  

• List of values  

To add values to or remove values from the list, do the following:  

• Type each value in the field, and then press Enter or click the Add button at 
the top of the form.  

• Repeat this process until your list of values is complete. 

For example, a list of values might include several user-defined codes for search 
types, such as C for Customers, E for Employees, and V for Vendors. Only is 
equal to and is not equal to are valid logical operators when using List of values.  

• To delete a value, choose the value and click Delete.  

• Click OK when you are finished.  
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12. To delete a line of criteria on Data Selection, choose the row header to highlight the 
row, and then click the Delete button.  

13. To change the order of the criteria, choose the row header to highlight the row, and 
then click the up or down button.  

14. Click Next.  

 

► To define output  

1. On the Select Outputs form, drag the table or tables that you want to use as your 
outputs to the Description pane on the right and click Next. 

2. For text file conversions, from the Text File tab, choose the file that you want to use 
as your output and click Use. 

Note 
On the AS/400®, output text files are stored in the integrated file system (IFS). Type 
the path to the IFS before the file name. 

 

3. Click Next. 

4. To delete an output, choose the row and press Delete.  

Notes 
If you are using a text file or if you need to define a user-defined format for a table or 
business view, click the User Defined Format button and follow the steps described in 
Importing and Exporting Text Files in the Table Conversion Guide. 

 

5. Click Next.  

6. On Table Options, click any of the following options, if applicable: 

• Run Currency Triggers 

Choose this option if the J.D. Edwards software table or tables contain currency 
triggers. If the tables contain currency fields and you do not choose this option, 
the system will not know how many decimal places exist in each column. Any 
time that the source or destination fields are currency fields and you do not turn 
on the currency trigger, problems could arise if the value is used in a calculation. 
The system has no way to determine where the decimal should be within a field.  

You might not want to choose the Run Currency Triggers option if the input and 
output data sources are of the same type (for example, Oracle, AS/400, or SQL 
Server) and no calculations are being performed. Choosing this option results in 
slower processing time.  

You should not use currency triggers for an environment that has a different path 
code than the login environment. 

• Clear Output Tables 
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• Force Row by Row Processing 

Choose this option if, for example, you want to test the table conversion or if you 
want to ensure that the conversion always runs in row-by-row mode.  

You might want to test a conversion to ensure that the mapping logic will perform 
correctly. In this case, you would also want to specify the number of rows to 
process. Specify the number of rows to process in the jde.ini file under 
[TCEngine] or when you submit the conversion.  

Choose this option if you know that the values in the input table will produce 
duplicate keys in the output, and you want the non-duplicate keys to be inserted.  

Choosing this option results in slower processing time.  

• Buffer Inserts To Output Tables  

Choose this option to improve conversion performance if you have no event rules 
in place to process insertion errors and if you are processing row by row.  

7. Click Next.  

 

► To map inputs to outputs  

1. On the Mapping form, specify the event on which you want mapping to occur by 
choosing an event from the Events list. 

In most cases, you use either the Row Fetched event or Format Fetched event. For 
example, if you are working with a user-defined format, choose the Format Fetched 
event.  

2. Click Advanced ER to further modify your mappings based on a particular event.  

3. Click Map Same to map your inputs directly to outputs. 

For example, if your input and outputs share some of the same data, these map 
directly. For J.D. Edwards software tables, the system maps by data dictionary item. 
For non-J.D. Edwards software tables, the system maps by column name.  

4. Drag inputs to outputs to define exactly where you want information to map.  

Note 
Click Delete to erase the mapping for a selected output. Click Delete All to erase the 
mapping for all outputs. 

 

5. If you have multiple output files, choose each file from the outputs list and map the 
appropriate input columns to output columns.  

6. To define advanced output, double-click an output column.  

The Advanced Outputs form appears. This form allows you to define literals, 
calculations, and various other mappings without using Advanced ER. You might 
want to use an advanced input to add a constant, literal value into a field. Or, you 
might want to insert a calculation into an output field, such as adding two input fields 
together.  
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7. On Advanced Outputs, click one of the following tabs and add the appropriate input: 

• Available objects 

Choose the output column, choose the appropriate value, and then click Apply.  

• Literal 

Choose the output column, enter the appropriate value, and click Apply.  

• Defaults 

Choose the Use Dictionary Defaults option, and then click Apply.  

Use this option if you want to use the default value in the data dictionary at run 
time. If no default values exist in the data dictionary, the system displays a 
warning message.  

• Calculation 

Click Define Calculation and define a calculation in Expression Manager.  

8. When you have finished defining an advanced input, click Apply, and then click 
Close.  

9. On Mapping, choose the Issue a Write for this Event option to insert a row to the 
selected output after performing all column mappings for this event.  

When you choose the Issue a Write for this Event option, the system attaches the TC 
Insert Row event. This event is automatically inserted at the end of the event rules. 
You cannot move it to another area. If you want to specify when a row is inserted and 
where, attach the User Insert Row system function using Advanced ER and move it 
wherever you like.  

10. Click Next.  

See Also 
� The Flow of Events in Table Conversion in the Table Conversion Guide for 

information about Row Fetched and Format Fetched events 

� Using Event Rules in a Table Conversion in the Table Conversion Guide for 
information about event rules 
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► To choose logging options  

The Logging Options form appears. 

1. Choose one or more logging options, if applicable: 

• Log All Errors 

• Log Every Input Record 

• Log Outputs 

• Log Deletes 

• Log Updates 

• Trace Level 

• Log Details of Copy Table Actions 

2. If you want to preview the actions of the table conversion before you run the actual 
conversion, choose the Run in Proof Mode option.  

Caution 
Proof mode is not an absolute proof mode. In some situations, the proof output might 
differ from the real output. If you insert the same record twice, for example, it will 
seem as though it worked in proof mode but, in reality, only one of the inserts will 
work when you run the conversion in final mode. 

 

3. Click Next.  

 

► To review the results of the director  

The Finish form appears. 

1. Choose one of the following options: 

• Yes, create a version of this table conversion 
If you choose Yes, enter the version name. 

• No, I will create a version of this table conversion later 

2. Click Finish to complete the process.  

If you chose Yes in step 1, a Warning appears. 

3. On the warning, click OK. 

The system displays the Properties form and the Table Conversion Mappings form.  

4. Choose the Table Conversions Mappings form and review your choices.  

5. Make changes as necessary by choosing the appropriate option from the View menu. 
If satisfied, click Save.  

6. From the Conversion menu, choose Exit.  

19 



See Also 
� Reviewing Your Table Conversion in the Table Conversion Guide 

Example: Data Conversion  

This data conversion example copies employee records from the Address Book Master 
(F0101) table in the Login Environment to the Address Book Master (F0101) table in the 
CMB9 environment. 

The Introduction form of the Table Conversion Director appears. 

1.   Choose the Data Conversion option, and then click Next. 

The External Data form appears. 

2.   Accept the default value and click Next. 

The Select Environments form appears. 

3.   Choose <LOGIN ENV> for the input and CMB9 for the output environment, and click 
Next. 

The Select Input form appears. 

4.   From the Table tab, choose Address Book Master and click Next.  

Note 
To find Address Book Master, you can enter F0101 in the QBE line for Object Name. 

 
The Sequencing form appears. 

5.   Accept the default values and click Next. 

The Data Selection form appears. 

6.   Set the data selection criteria to “Where Search Type (AT8) is equal to E” to choose 
current employees, and click Next. 

The Select Outputs form appears. 

7. From the Tables tab, choose Address Book Master and click Next. 

The Table Options form appears. 

8. Since the Address Book Master file does not contain monetary information, remove 
the check mark for Run Currency Triggers and then click Next. 

The Mapping form appears. 

9. Since you are converting data from similar files, click Map Same and click Next. 

The system automatically maps data elements with the same aliases to each other. 

The Logging Options form appears. 
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10. Choose Select Log All Errors and Log Outputs so that you can review the conversion 
after it is complete and then click Next. 

The Finish form appears. 

11. Choose “No, I will create a version of this table conversion later” and click Finish. 

The Table Conversion Review form displays. 

12. Click Save before exiting. 

You have created a table conversion. 

User-Defined Formats 

The table conversion tool uses user-defined formats to handle fixed-width or character-
separated value (CSV) files in a table or text file. These files are collectively known as flat 
files because they do not have relationships defined for them as relational database tables 
do. Usually, flat files are text files stored on your workstation or server. They are used to 
import or export data from applications that have no other means of interaction. For example, 
you might want to share information between J.D. Edwards software and another application, 
but if the non-J.D. Edwards software application does not support one of the same databases 
that J.D. Edwards software supports, then flat files might be the only way to transfer data 
between the two applications.  

In a flat file, records are stored as one continuous string of information. The user-defined 
format provides instruction on how data is presented.  

The following example illustrates a single database character column that has a user-defined 
format with five columns: Last, First, Addr, City, and Phone:  

Database Column Doe John 123 Main Anytown 5551234 

Last First Addr City Phone 

 

This example is a fixed-width column format in which all of the data for each column starts in 
the same relative position in each row of data.  

The same data in a character-delimited format would look like the following example:  

"Doe", "John", "123 Main", "Anytown", 5551234  

Importing and Exporting Text Files 

When you choose a text file as input to or output from a table conversion and do not specify a 
path, a default path is used. Conversions stored with the default path run on any platform. If 
an explicit path or AS/400 library name is indicated for the file, then the file is located or 
created exactly as specified. Conversions stored this way may not work on other platforms, 
depending on the nature of the file system on each platform.  

The default paths on non-AS/400 platforms are:  

path code\Import\file name  

path code\Export\file name  
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You cannot specify a default path for the AS/400. Rather, the default will always be the 
Import or the Export directory under the path code of the input or output environment. For 
example, if you are running a conversion against an APPL_PGF environment, the path in the 
file system might be:  

\B9\appl_pgf\import\myfile.txt  

If the conversion specifies a file name with anything other than the file name and extension, 
such as library/file(mbr) or \mytextfiles\myfile.txt, the conversion will try to 
open the file as specified.  

Using User-Defined Formats as Input 

If you use user-defined input formats, add an event rule at the Format Fetched Event.  If you 
do not, the system ignores the format and the data from the input table is never made 
available to the conversion. If you do not add an event rule, at least add a comment in Event 
Rules. 

User-defined formats work with text files and tables.  

Because the procedure for importing and exporting is database-specific, you should consult 
your database administrator for details.  

Using User-Defined Formats as Output 

If you use user-defined output formats, add an event rule at the Format Fetched Event.  If you 
do not, the system ignores the format and the data from the input table is never made 
available to the conversion. If you do not add an event rule, at least add a comment in Event 
Rules. 

User-defined formats work with text files and tables.  

Because the procedure for importing and exporting is database-specific, you should consult 
your database administrator for details.  

 

► To define delimited, single- or multiple-format files 

Use the Navigation Assistant to move to the Select Input form or the Select Outputs form. 
You can also use the Back or Next buttons to navigate to these forms in the director. 
Alternatively, you can click the Select Input tab or Select Outputs tab in Table Conversion 
Properties.  

1. On Select Input or Select Outputs, ensure that you have chosen a table, business 
view, or file. Choose User Defined Format, and then click Define Format(s).  

The User Defined Format - Type form appears.  

2. Choose the delimited format type. 
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3. Choose one of the following Row Formats and click Next: 

• Single Format on Rows On/Off 

• Multiple Formats on Rows On/Off 

The User Defined Format - Column Delimiter form appears.  

4. Choose the delimiter that separates the columns in the file:  

• Tab Delimiter 

• Comma Delimiter 

• Semicolon Delimiter 

• Space Delimiter 

• Other Delimiter 

5. Choose the textual qualifier that is used to enclose a string of text:  

• No Text Qualifier 

• Single Quotation Qualifier 

• Double Quotation Qualifier 

6. If you chose Single Format and the first row contains column headers, choose “The 
first row contains column headers.”  

7. Click Next.  

8. If you chose Multiple Format, the system displays Multiple Format Definition. If you 
chose Single Format, skip to Step 13.  

9. On User Defined Format - Multiple Format Definition, enter the number of formats 
that your user-defined format contains.  

10. To define the character length of the Designator column, complete the following field:  

• Length  

11. Click Next.  

The User Defined Format - Multiple Format Names form appears.  

12. In the Designator column, define the values for each format. 

The Designator name must match what is in your user-defined formats.  

For example, suppose you have a text file that contains purchase order information. 
Lines in the table with a first field designated as POH have information for a whole 
purchase order; lines with a first field designated as POI contain information about 
individual items in the purchase order; and lines in the table with a first field 
designated as POT contain information about purchase order totals. In this scenario, 
you would enter POH as the designator of the first format, POI as the designator of 
the second format, and POT as the designator of the third format.  
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Note 
You can also rename the columns for each format to make it easier to remember the 
formats with which you are working. For example, you can rename the columns 
according to their function in the file, such as Header, Detail, and Total. These names 
will appear in the Inputs drop down list in the Mapping section of the conversion. To 
rename columns, select the column and in the name field, change the name of the 
column.  

 

13. Click Next.  

The User Defined Format - Column Layout form appears.  

14. Choose a format from the list of Available Formats.  

You define the columns for the format so that the system can parse the information 
from the file.  

Note 
If you need to move the Format Designator, choose the row and drag it to the new 
location. 

  

15. For each column, click Add to define the column. 

The New Column Properties form appears.  

16. Modify the following fields as needed, and then click OK:  

• Name 

• Length 

• Data Type 

17. For each column, repeat steps 13 through 16.  

18. To edit an existing column, choose it and click the Edit button. Change the properties 
in the Column Properties form.  

19. To model the columns after an existing table, business view, or foreign table, click the 
Model button, click the appropriate tab, and then choose the table or business view 
that you want to use as a model for the user-defined format.  

Note 
You cannot model the columns after an existing object unless the layout of the two 
objects matches. 

 

20. Click OK.  

The system copies the format from the model that you chose and places it into the 
column layout grid.  
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21. Click Next.  

The User Defined Format - Finish form appears.  

22. Click Finish when you have completed defining formats. 

The system returns to the Select Input or Select Outputs form.  

 

► To define fixed-width, single- or multiple-format files 

Use the Navigation Assistant to move to the Select Input form or the Select Outputs form. 

1. Choose User Defined Format, and then click Define Format(s).  

The User Defined Format - Type form appears.  

2. Choose the fixed width format. 

3. Choose one of the following Row Formats and click Next:  

• Single Format on Rows On/Off 

• Multiple Formats on Rows On/Off 

4. If you chose Single Format, skip to step 10. If you chose Multiple Format, the system 
displays the Multiple Format Definitions form.  

5. On User Defined Format - Multiple Formats Definition, enter the number of formats 
that your user-defined file contains.  

6. Complete the following fields: 

• Start Position  

• Length  

The Start Position and Length fields define the position of the data for the rows. Start 
Position defines where the column starts, and Length defines the character length of 
the designator.  

7. Click Next.  

The User Defined Format - Multiple Format Names form appears.  

8. In the Designator column, define the values for each format. 

The Designator name must match what is in your user-defined formats.  

For example, suppose you have a text file that contains purchase order information. 
Lines in the table with a first field designated as POH have information for a whole 
purchase order; lines with a first field designated as POI contain information about 
individual items in the purchase order; and lines in the table with a first field 
designated as POT contain information about purchase order totals. In this scenario, 
you would enter POH as the designator of the first format, POI as the designator of 
the second format, and POT as the designator of the third format.  
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Note 
You can also rename the columns for each format to make it easier to remember the 
formats with which you are working. For example, you can rename the columns 
according to their function in the file, such as Header, Detail, and Total. These names 
will appear in the Inputs drop down list in the Mapping section of the conversion. To 
rename columns, select the column and in the name field, change the name of the 
column. 

 

9. Click Next.  

The User Defined Format - Column Layout form appears.  

10. Choose a format from the list of Available Formats.  

You define the column so that the system can parse the information from the file.  

Note 
If you need to move the Format Locator, choose the row and drag it to the new 
location. 

 

11. For each column, click Add to define the column layout. 

12. On the New Column Properties form, modify the following fields as needed, and then 
click OK:  

• Name 

• Start 

• Length 

• Data Type 

13. For each column, repeat steps 11 through 12.  

14. To edit an existing column, choose it and click the Edit button. Change the properties 
in the Column Properties form.  

15. To model the columns after an existing table, business view, or foreign table, click the 
Model button, click the appropriate tab, and then choose the table or business view 
that you want to use as a model. 

16. Click OK.  

The system copies the format from the model that you chose and places it into the 
column layout grid.  

17. Click Next.  

The system displays the summary of user-defined formats that you have defined.  

18. Click Finish when you are finished defining formats.  

The system returns to the Select Input or Select Outputs form.  
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See Also  
� Defining Section Data Sequencing in the Enterprise Report Writing Guide for 

information about how to determine a sort sequence for a batch process 

� Reviewing Your Table Conversion in the Table Conversion Guide 

� Using Event Rules in a Table Conversion in the Table Conversion Guide 

� Running a Table Conversion in the Table Conversion Guide 
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Data Copy 

You use the Data Copy option in the Table Conversion Director to copy one or more tables 
from one environment or data source to another. You also can import a copy table script to 
use in the conversion.  

The Director leads you through a linear process for creating a data conversion batch 
application by asking you questions about its structure and function. When you are finished, 
you can review and modify the conversion, if necessary.  

Before You Begin  
� Create a batch application object. See Using the Table Conversion Director in the 

Table Conversion Guide for information about starting the data conversion design 
process and the Director. The last step launches the Director.  

 

► To define external data  

The Introduction form of the Table Conversion Director appears. 

1. Choose the Data Copy option and click Next. 

The External Data form appears.  

2. If you want to attach a predefined processing option template to the table conversion, 
click Select.  

3. On the Select Processing Option Template form, find and choose the processing 
option that you want to use and click OK.  

4. If you want to attach data structures, click Define on the External Data form. 

The Report Data Structures form appears. Data structures contain a list of 
parameters that can be used to pass data into the conversion when called through 
Report Interconnect. 

5. Define the data structures that you want to attach to the table conversion and click 
OK.  

6. Click Next.  

See Also 
� Data Structures in the Development Tools Guide 
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► To define input and output environments  

1. On the Select Environments form, choose the input and output environments that you 
want to use. 

Note 
Choose <LOGIN ENV> if you are creating a table conversion on your workstation 
that will be shipped to a client who does not have the environments that you have. 
The table conversion will use the client login environment. 

 

2. If you are creating a table conversion that will run in a different environment than the 
one in which you are creating it and the <LOGIN ENV> is not appropriate for the type 
of conversion that you are creating, click the Force Version to Override Input 
Environment option or the Force Version to Override Output Environment option. 

For example, if you create a conversion that will be shipped to a client who does not 
have the environments that you have, you would turn on these options. When the 
conversion is invoked at the client site, the system will not run the conversion until the 
user chooses an appropriate environment in which to run it.  

3. Click Next.  

 

► To define data copy actions  

The Select Actions form appears. 

1. Complete the following fields using the drop-down lists in each field to make your 
choice:  

When you enter the name of a table and then tab to the next field, the system 
automatically populates the remaining fields for you. You can make changes to these 
fields as necessary.  

• Table 

If you want to copy a single table, choose <Literal> and enter the name of that 
table on the Single Value Tab.  

If you do not know the name of the table that you want to copy, use the <Find a 
Table> option.  

• To Table 

Enter either the last table in a range of tables to be copied or leave this field 
blank if you are copying a single table.  

• Source Type 

Choose Data Source if your input and output sources are data sources. Choose 
Environment if your input and output sources are environments. When you 
choose Data Source or Environment, the appropriate system function (such as 
CopyTableEnvironment or CopyTableDataSource) is invoked during processing.  
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The Data Source function works in the same way as Copy Table and gets its 
table descriptions from the specifications in the login environment.  

The Environments function uses the input and output environment to locate data 
and specifications for the tables, which allows the specifications to be different in 
the input and output environment but the data is copied. In this case, the system 
performs a "copy-map-drop" action.  

• Input Source 

The input source is the data source or environment from which the inputs will be 
read.  

• Output Source 

The output data source is the source or environment where the output is written.  

• Create 

If you choose <If Table Exists>, the system creates the table and runs the 
conversion only if both the table specification and the actual table exist in the 
input.  

If you choose <Yes>, the system creates the table. If the table already exists in 
the output, the system deletes and re-creates it.  

If you choose <No>, the system assumes the table already exists in the output 
and does not re-create it.  

• Clear 

If you choose <If Table Exists>, the system clears the table only if it exists in the 
input.  

If you choose <Yes>, the system deletes all rows in the output table before 
copying the table.  

If you choose <No>, the output table will not be cleared.  

Note 
Choosing not to clear the output table might result in key conflicts. 

 
• Copy 

If you choose <Yes>, the system copies the data from the input table to the 
output table using Map Same.  

If you choose <No>, no data is copied.  

• Owner ID 

• Owner Pwd 

If the data source requires an owner ID and password, enter them here. If you 
leave these fields blank, the system enters the ID and password of the login user, 
or <None> if the data source does not have security.  
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2. To import an existing copy table script from another location, click the Import button. 
On Open, find the file that you want to import and click Open.  

The system adds an action for each copy table item in the copy table script.  

3. On Select Actions, click Advanced ER to add event rules to the copy table process.  

You can use Event Rules to write a custom copy table script.  

4. Click Next.  

See Also 
� Using Event Rules in a Table Conversion in the Table Conversion Guide for 

information about system functions 

 

► To choose logging options  

The Logging Options form appears. 

1. Choose one or more logging options, if applicable. 

• Log All Errors  

• Trace Level 

• Log Details of Copy Table Actions 

2. If you want to preview the actions of the table conversion before you run the actual 
conversion, choose the Run in Proof Mode option.  

3. Click Next.  

 

► To review the results of the director  

The Finish form appears. 

1. Choose one of the following options: 

• Yes, create a version of this table conversion 
If you choose Yes, enter the version name. 

• No, I will create a version of this table conversion later 

2. Click Finish to complete the process.  

If you chose Yes in step 1, a Warning message displays. 

3. Click OK. 

The system displays Table Conversion Actions.  

4. Review your choices and, if satisfied, click Save.  

5. From the File menu, choose Exit.  

You can now run the table conversion.  
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See Also  
� Using Event Rules in a Table Conversion in the Table Conversion Guide 

� Reviewing Your Table Conversion in the Table Conversion Guide 

� Running a Table Conversion in the Table Conversion Guide 
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Data Copy with Table Input  

Data Copy with Table Input is similar to Data Copy except that it also allows information for 
the process to come from an input table. The input table might provide information about 
which tables should be copied, where they should be copied, and so on. Data Copy with 
Table Input also allows you to select data. 

For example, you create a table that has a table name, the next backup date, and the backup 
frequency. You might populate the table with a list of tables to be archived and information 
specifying how often they should be archived. You then can use Data Copy with Table Input 
to choose all rows in which the backup date is less than or equal to today's date, and 
calculate a new backup date.  

The Director leads you through a linear process for creating a data conversion batch 
application by asking you questions about its structure and function. When you are finished, 
you can review and modify the conversion, if necessary.  

Before You Begin  
� Create a batch application object. See Using the Table Conversion Director in the 

Table Conversion Guide for information about starting the data conversion design 
process and the Director. The last step launches the Director.  

 

► To define external data  

The Introduction form of the Table Conversion Director appears. 

1. Choose the Data Copy with Table Input option and click Next. 

The External Data form appears.  

2. If you want to attach a predefined processing option template to the table conversion, 
click Select.  

3. On the Select Processing Option Template form, find and choose the processing 
option you want to use and click OK.  

4. If you want to attach data structures, click Define on the External Data form. 

The Report Data Structures form appears. Data structures contain a list of 
parameters that can be used to pass data into the conversion when called through 
Report Interconnect. 

5. Define the data structures that you want to attach to the table conversion and click 
OK.  

• Output Source 

6. Click Next.  

See Also 
� Data Structures in the Development Tools Guide 
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► To define input and output environments  

1. On the Select Environments form, choose the input and output environments that you 
want to use. 

Note 
Choose <LOGIN ENV> if you are creating a table conversion on your workstation 
that will be shipped to a client who does not have the environments that you have. 
The table conversion will use the client login environment. 

 

2. If you are creating a table conversion that will run in a different environment than the 
one in which you are creating it and the <LOGIN ENV> is not appropriate for the type 
of conversion that you are creating, click the Force Version to Override Input 
Environment option or the Force Version to Override Output Environment option. 

For example, if you create a conversion that will be shipped to a client who does not 
have the environments that you have, you would turn on these options. When the 
conversion is invoked at the client site, the system will not run the conversion until the 
user chooses an appropriate environment in which to run it.  

3. Click Next.  

 

► To define input  

The Select Input form appears. 

1. Drag the table or business view to the column on the right. 

You can choose only one table or one business view per conversion. If your input 
consists of multiple tables, you must create a single joined business view. 

Notes 
If you know the name of the table or business view you want to use, enter the name 
in the Name field in the QBE (query by example) row and press Enter. Alternately, for 
text files, you can select a file from the default directory, enter a new file name, or 
click the Browse button to locate a file.  

If you change the table, business view, or file, the system warns you that deleting 
tables removes all mappings from the table conversion. 

 

2. If you are working with a user-defined format (flat file), click User-Defined Format. 

Note 
Follow the steps described in User-Defined Formats in the Table Conversion Guide. 
When you complete those steps, return here. 

  

3. To delete an input name, choose it and press Delete.  

4. Click Next.  

The Sequencing form appears.  
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5. To define data sequencing for a table or business view, click Data Sequencing. 

If you specify a text file for input, you cannot define data sequencing or selection for 
that file.  

When you define data sequencing, you create new events that are available to you in 
the Mapping section of the Director. One new event is created for each of the 
sequence columns that you define. The event is called XXXX Data Changed, where 
XXXX is the column alias; for example, ALPH Data Changed. Each time that the 
value in one of these columns changes from its previous value, the column's Data 
Changed event is invoked. This event is similar to a level break in report writing with 
the exception that the Data Changed events are not related to each other. Invoking 
one does not invoke the others.  

6. Click Next.  

The Data Selection form appears. On this form, you can only define selection criteria 
over database table columns. User-defined format columns are unavailable because 
they do not exist in the database.  

Where is the default value in the Operator column for the first set of criteria. For 
subsequent statements, And and Or become the available values for the Operator 
column and are selected by double-clicking the appropriate one.  

7. Click the Left Operand column to display the list of available objects, and then 
perform one of the following:  

• Scroll through the list until you find the desired object, choose the object, and 
then double-click the object to populate the Left Operand column.  

• Type in the first letters of the object name in the Left Operand field to bring you to 
the object in the list, and then double-click the highlighted object.  

When you double-click the object for the Left Operand column, the list in the 
Comparison column automatically appears.  

8. Choose one of the following comparison operators:  

• is equal to  

• is greater than  

• is greater than or equal to  

• is less than  

• is less than or equal to  

• is not equal to  

9. Click the Right Operand column to display an available list of objects, special values, 
or variables. 

Your choices in this column depend on the choice that you made in the Comparison 
column. Some of the following options could be available:  
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Blank  Enters a blank (space) value  

Literal  Enter specific values (see the following step for information on entering specific values)  

Null  Indicates that no value is associated with the field  

Zero  Enters a value of zero  

IC  Indicates an input table column  

RI  Indicates a value passed through report interconnections to this table conversion  

PO  Indicates a processing options value for this report  

SL  Indicates a system literal  

10. If you chose to enter a literal in the Right Operand column, the form that opens 
automatically enables you to enter the following:  

• Single value 

Enter a single value, and then click OK. For example, a value might be for a 
particular company.  

• Range of values 

Enter a range of values, and then click OK. For example, a range of values might 
include companies from 00001 to 00060. Only is equal to and is not equal to are 
valid logical operators when using range of values.  

• List of values  

To add values to or remove values from the list, do the following:  

• Type each value in the field, and then press Enter or click the Add button at 
the top of the form.  

• Repeat this process until your list of values is complete. 

For example, a list of values might include several user defined codes for search 
types such as C for Customers, E for Employees, and V for Vendors. Only is 
equal to and is not equal to are valid logical operators when using list of values.  

• Delete a value by choosing the value, and then click Delete at the top of the 
form.  

• Click OK when you are finished.  

11. To delete a line of criteria on Data Selection, choose the row header to highlight the 
row, and then click Delete at the top of the form.  

12. To change the order of the criteria, choose the row header to highlight the row, and 
then click the up or down button.  

13. Click Next.  

The Table Options form appears.  
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14. Choose the Run Currency Triggers option, if applicable. 

Choose this option if the J.D. Edwards software table or tables contain currency 
triggers. If the tables contain currency fields and you do not choose this option, the 
system does not know how many decimal places exist in each column. Any time the 
source or destination fields are currency fields and you do not turn on the currency 
trigger, problems can arise if the value is used in a calculation because the system 
has no way to determine where the decimal should be within a field.  

You might not want to choose the currency trigger option if the input and output data 
sources are the same type (for example, Oracle, AS/400, or SQL Server) and no 
calculations are being performed. Choosing this option results in slower processing 
time.  

In addition, you should not use currency triggers on an environment that has a 
different path code than the login environment.  

15. Click Next.  

See Also 
� The Flow of Events in Table Conversion in the Table Conversion Guide for 

information about the Data Changed event 

 

► To define data copy actions  

The Select Actions form appears. 

1. Complete the following fields using the drop-down lists in each field to make your 
choice:  

When you enter the name of a table and then tab to the next field, the system 
automatically populates the remaining fields for you. You can make changes to these 
fields as necessary.  

• Table 

If you want to copy a single table, choose <Literal> and enter the name of that 
table on the Single Value Tab.  

If you do not know the name of the table that you want to copy, use the <Find a 
Table> option.  

• To Table 

Enter either the last table in a range of tables to be copied or leave this field 
blank if you are copying a single table.  

• Source Type 

Choose Data Source if your input and output sources are data sources. Choose 
Environment if your input and output sources are environments. When you 
choose Data Source or Environment, the appropriate system function (such as 
CopyTableEnvironment or CopyTableDataSource) is invoked during processing.  

The Data Source function works in the same way as Copy Table and gets its 
table descriptions from the specifications in the login environment.  
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The Environments function uses the input and output environment to locate data 
and specifications for the tables, which allows the specifications to be different in 
the input and output environment but the data is copied. In this case, the system 
performs a "copy-map-drop" action.  

• Input Source 

The input source is the data source or environment from which the inputs will be 
read.  

• Output Source 

The output data source is the source or environment where the output is written.  

• Create 

If you choose <If Table Exists>, the system creates the table and runs the 
conversion only if both the table specification and the actual table exist in the 
input.  

If you choose <Yes>, the system creates the table. If the table already exists in 
the output, the system deletes and re-creates it.  

If you choose <No>, the system assumes the table already exists in the output 
and does not re-create it.  

• Clear 

If you choose <If Table Exists>, the system clears the table only if it exists in the 
input.  

If you choose <Yes>, the system deletes all rows in the output table before 
copying the table.  

If you choose <No>, the output table will not be cleared.  

Note 
Choosing not to clear the output table might result in key conflicts. 

 
• Copy 

If you choose <Yes>, the system copies the data from the input table to the 
output table using Map Same.  

If you choose <No>, no data is copied.  

• Owner ID 

• Owner Pwd 

If the data source requires an owner ID and password, enter them here. If you 
leave these fields blank, the system enters the ID and password of the login user, 
or <None> if the data source does not have security.  
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2. To import an existing copy table script from another location, click the Import button. 
On Open, find the file that you want to import and click Open.  

The system adds an action for each copy table item in the copy table script.  

3. On Select Actions, click Advanced ER to add event rules to the copy table process.  

You can use Event Rules to write a custom copy table script.  

4. Click Next.  

 

► To choose logging options  

The Logging Options form appears. 

1. Choose one or more logging options, if applicable: 

• Log All Errors 

• Delete All Selected Records 

• Log Deletes 

• Log Updates 

• Trace Level 

• Log Details of Copy Table Actions 

2. If you want to preview the actions of the table conversion before you run the actual 
conversion, choose the Run in Proof Mode option.  

3. Click Next.  

 

► To review the results of the director  

The Finish form appears. 

1. Choose one of the following options: 

• Yes, create a version of this table conversion 
If you choose Yes, enter the version name. 

• No, I will create a version of this table conversion later 

2. Click Finish to complete the process.  

If you chose Yes in step 1, a Warning message displays. 

3. Click OK. 

The system displays Table Conversion Actions.  

4. Review your choices and, if satisfied, click Save.  
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5. From the File menu, choose Exit.  

You can now run the table conversion.  

See Also  
� Using Event Rules in a Table Conversion in the Table Conversion Guide 

� Reviewing Your Table Conversion in the Table Conversion Guide 

� Running a Table Conversion in the Table Conversion Guide 
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Batch Delete  

The Batch Delete option allows you to delete a range of records from a J.D. Edwards 
software input table or foreign table, based on selection criteria that you define. For example, 
you can set up a batch delete table conversion that deletes any records in an input table that 
do not contain valid data or records. You might also want to set up a conversion that deletes 
all records from a particular table.  

The Director leads you through a linear process for creating a data conversion batch 
application by asking questions about its structure and function. When you are finished, you 
can review and modify the conversion, if necessary.  

Before You Begin  
� Create a batch application object. See Using the Table Conversion Director in the 

Table Conversion Guide for information about starting the data conversion design 
process and the Director. The last step launches the Director.  

 

► To define external data  

The Introduction form of the Table Conversion Director appears. 

1. Choose the Batch Delete option and click Next. 

The External Data form appears.  

2. If you want to attach a predefined processing option template to the table conversion, 
click Select.  

The Select Processing Option Template form appears. 

3. On Select Processing Option Template, find and choose the processing option that 
you want to use and click OK.  

4. If you want to attach data structures, click Define on the External Data form. 

The Report Data Structures form appears. Data structures contain a list of 
parameters that can be used to pass data into the conversion when called through 
Report Interconnect. 

5. Define the data structures that you want to attach to the table conversion and click 
OK.  

• Output Source 

6. Click Next.  

See Also 
� Data Structures in the Development Tools Guide 
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► To define the environment  

The Select Environment form appears. 

1. Choose the environment in which the table resides.  

Note 
Choose <LOGIN ENV> if, for example, you are creating a table conversion on your 
workstation that will be shipped to a client who does not have the environments that 
you have. The environment they log on to will always be appropriate. 

 

2. Choose the Force Version to Override Input Environment option or theForce Version 
to Override Output Environment option if you are creating a table conversion that will 
run in a different environment than the one in which you are creating it, and the 
<LOGIN ENV> is not appropriate for the type of conversion that you are creating.  

For example, if you create a conversion that will be shipped to a client who does not 
have the environments that you have, you would choose the Force Version to 
Override option. When the conversion is invoked at the client site, the system will not 
run the conversion until the user chooses an appropriate environment in which to run 
it.  

3. Click Next.  

 

► To define input  

The Select Input form appears. 

1. Drag the table to the column on the right. You can choose only one table per 
conversion. 

If you know the name of the table that you want to use, enter the name in the Name 
field in the query by example line and press Enter. For text files, choose a file from 
the default directory, enter a new file name, or click the Browse button to locate a file.  

Note 
If you change the table, the system warns you that deleting tables removes all 
mappings from the table conversion. 

 

2. To delete an input name, choose it and press Delete.  

3. Click Next.  

The Table Options form appears.  

4. Choose the Run Currency Triggers option, if applicable. 

Choose this option if the J.D. Edwards software table or tables contain currency 
triggers. If the tables contain currency fields and you do not choose this option, the 
system does not know how many decimal places exist in each column. Any time that 
the source or destination fields are currency fields and you do not turn on the 
currency trigger, problems could arise if the value is used in a calculation. The 
system has no way to determine where the decimal should be within a field.  
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You might not want to choose the currency trigger option if the input and output data 
sources are the same type (for example, Oracle, AS/400, or SQL Server), and no 
calculations are being performed. Furthermore, choosing the currency trigger option 
results in slower processing time.  

In addition, you should not use currency triggers on an environment that has a 
different path code than the login environment.  

5. On the Data Selection form, define selection criteria over database table columns. 

User-defined format columns are unavailable because they do not exist in the 
database.  

Where is the default value in the Operator column for the first set of criteria. For 
subsequent statements, And and Or become the available values for the Operator 
column and are selected by double-clicking the appropriate one.  

6. Click the Left Operand column to display the list of available objects, and then do one 
of the following:  

• Scroll through the list until you find the desired object, choose the object, and 
then double-click the object to populate the Left Operand column.  

• Type the first letters of the object name in the Left Operand field to bring you to 
the object in the list, and then double-click the highlighted object.  

When you double-click the object for the Left Operand column, the list in the 
Comparison column automatically appears.  

7. Choose one of the following comparison operators:  

• is equal to  

• is greater than  

• is greater than or equal to  

• is less than  

• is less than or equal to  

• is not equal to  

8. Click the Right operand column to display an available list of objects, special values, 
or variables. Your choices in this column depend on the choice you made in the 
Comparison column. Some of the following options could be available:  

Blank  Enters a blank (space) value  

Literal  Enter specific values (see the following step for information on entering specific values)  

Null  Indicates that no value is associated with the field  

Zero  Enters a value of zero  

IC  Indicates an input table column  

RI  Indicates a value passed through report interconnections to this table conversion  
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PO  Indicates a processing options value for this report  

SL  Indicates a system literal  

VA  Indicates an event rule variable  

9. If you chose to enter a literal in the Right operand column, the form that opens 
automatically enables you to enter the following:  

• Single value 

Enter a single value, and then click OK. For example, a value might be for a 
particular company.  

• Range of values 

Enter a range of values, and then click OK. For example, a range of values might 
include companies from 00001 to 00060. Only is equal to and is not equal to are 
valid logical operators when using range of values.  

• List of values  

To add values to or remove values from the list, do the following:  

• Type each value in the field, and then press Enter or click the Add button at 
the top of the form.  

• Repeat this process until your list of values is complete. For example, a list of 
values might include several user defined codes for search types such as C 
for Customers, E for Employees, and V for Vendors. Only is equal to and is 
not equal to are valid logical operators when using list of values.  

• Delete a value by choosing the value, and then click the Delete button at the 
top of the form.  

• Click OK when you are finished.  

10. To delete a line of criteria on Data Selection, choose the row header to highlight the 
row, and then click the Delete button at the top of the form.  

11. To change the order of the criteria, choose the row header to highlight the row, and 
then click the up or down button.  

12. In the Events field, choose the appropriate event from the drop-down list. You must 
choose Row Fetched as the event where the delete occurs; otherwise, no records will 
be deleted.  

When you run the conversion, the system will fetch the rows one at a time, run the 
conversion for each row, and delete the record from the input.  

13. Make sure the Delete all selected records option is checked. 

This option inserts the Delete Current Input Row event into Event Rules.  

14. Click the Advanced ER button if you want to add event rules to define more 
complicated actions than simply deleting all selected records.  

15. Click Next.  
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See Also 
� Using Event Rules in a Table Conversion in the Table Conversion Guide for more 

information about table conversion event rules 

 

► To choose logging options  

The Logging Options form appears. 

1. Choose one or more logging options, if applicable. 

• Log All Errors 

• Delete All Selected Records 

• Log Deletes 

• Log Updates 

• Trace Level 

• Log Details of Copy Table Actions 

2. If you want to preview the actions of the table conversion before you run the actual 
conversion, choose the Run in Proof Mode option.  

3. Click Next.  

 

► To review the results of the director  

The Finish form appears. 

1. Choose one of the following options: 

• Yes, create a version of this table conversion 
If you choose Yes, enter the version name. 

• No, I will create a version of this table conversion later 

2. Click Finish to complete the process.  

If you chose Yes in step 1, a Warning form appears. 

3. On the Warning form, click OK. 

The system displays the Selection for Batch Delete form.  

4. On Table Conversion Actions, review the options that you specified for the batch 
delete conversion. If you are satisfied with your choices, click Save. Otherwise, make 
changes as necessary and then click Save.  

5. From the File menu, choose Exit.  

You can now run the conversion.  
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See Also  
� Using Event Rules in a Table Conversion in the Table Conversion Guide 

� Reviewing Your Table Conversion in the Table Conversion Guide 

� Running a Table Conversion in the Table Conversion Guide 

Example: Batch Delete/Update  

This table conversion was created using the Batch Delete option, but it does not actually 
delete records. Instead, it is an example of how you can use a batch delete conversion to do 
general batch processing over a single table. You can create a similar table conversion using 
the data conversion option; however, it takes longer to create and also requires an output 
table.  

The following example updates all employee records in the F0101 table to make them ex-
employees. 

The Introduction form of the Table Conversion Director appears. 

1.   Choose Batch Delete and then click Next. 

The External Data form appears. 

2.   Specify whether you want to include processing options and data structures, and then 
click Next. 

For this example, no processing options or data structures are used. 

The Source Environment form appears. 

3.   Choose the environment in which you want to run the conversion, and then click 
Next. 

In this example, create and run the conversion in the login environment. The Force 
Version to Override Input Environment option is not chosen because it will not be 
ported to another system.  

The Select Input form appears. 

4.   Choose the F0101 table and then click Next.  

The Table Options form appears. 

5.   Because the F0101 table does not contain currency fields, do not choose the 
currency trigger option. 

6. Click Next. 

The Data Selection form appears. 

7. Choose all AT1 (Search Type) records that equal E (Employee). 

All employees will become ex-employees. 
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8. Choose Delete All Select Records and the Row Fetched event, and then click Next. 

The Logging Options form appears. 

If you click the Advanced ER button, you can see the system function that is added 
when you choose the Delete All Selected Records option on the previous form.  

9. Choose Run in Proof Mode to ensure that all records are changed, and click Next. 

The Finish form displays. 

10. Choose Yes, enter a version name, and click Next. 

11. On the warning that appears, click OK. 

The Table Conversion Review form displays. 

See Also 
� Running a Table Conversion in the Table Conversion Guide for more information 

about turning on logging and setting the trace level   
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Example: Creating a Purge Program as a Batch Delete  

The following example is a table conversion that deletes records from the input environment. 
Designing purge programs as batch deletes enables you to purge records with better control 
and greater accuracy. You can archive the data you purge or remove it from the system 
permanently. The archiving process is shown in this example. Before you start this example, 
create a handle for the table. 

The Introduction form of the Table Conversion Director appears.  

1.   Choose Batch Delete and click Next. 

The External Data form appears.  

2.   Choose a Processing Option template and click Next. 

For this example, use Purge Processing Option (T42000P). 

The Source Environment form appears. 

3.   Choose the source environment in which you want to run the batch delete and click 
Next. 

For this example, choose the login environment <LOGIN ENV>. Enable the Force 
Version to Override Input Environment option to make sure that the person who runs 
the purge program provides a valid source environment from which to run the batch 
delete. 

The Select Input form appears. 

4.   Choose the table you want to purge and drag it to the Description area, and click 
Next. 

For the example, choose, User Defined Code Types (F0004). 

The Table Options form appears. 

5.   Choose Run Currency Triggers.  

The Data Selection form appears. 

6.   Choose the data you want purged by clicking a field and double-clicking an option 
from the drop-down list. 

For this example, choose Where IC UCD1(User Defined Code) is equal to Null. 

7.   Click Next. 

The Logging Options form appears. 

8.   Choose the options you want logged, and then click Next. 

For this example, do not log any information.  

The Finish form appears. 
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9.   Choose “Yes, create a version of this table conversion” and enter the version name in 
the field. 

For this example, use XJDE001.   

10. On the warning form that appears, click OK. 

The Table Conversion Review form appears. 

11. In the Events field, choose Process Begin and click Advanced ER.  

The Event Rules Design form appears. 

12. Enter the begin process event rules, along with any special logic. 

For this example, use event rules for R42119P, as follows:  

0001 // Check to see if the purged data is being archived 

0002 // 

0003 If PO cArchiveRecords is equal to ”1” 

0004    // 

0005    // If the environment processing option is blank, stop processing. 

0006    // 

0007    If PO szArchiveEnvironmentName is equal to <Blank> 

            Or PO szArchiveEnvironmentName is equal to <Null> 

0008       Stop Conversion Processing(”The archive environment is invalid.”) 

0009    Else 

0010       // 

0011       // Check to make sure that the archive environment and data 

source is not the 

0012       // same as the input environment and data source 

0013       // 

0014       If PO szArchiveEnvironmentName is equal to SL SourceEnvironment 

0015          Stop Conversion Processing(”The source and archive 

environments are the same”) 

0016       Else 

0017          Get and validate the data source for an environment / table  

(B98700) 

                     PO szArchiveEnvironmentName -> szEnvironment 

                     ”F42119” -> szTableName 

                     VA rpt_szArchiveDataSource_DATS <- szDataSource 

                     VA rpt_szErrorCode_DTAI <- szErrorDataItem 

                     VA rpt_mnErrorNumber_MATH01 <- mnErrorNumber 

0018          If VA rpt_szErrorCode_DTAI is not equal to <Blank> 
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                  And VA rpt_szErrorCode_DTAI is not equal to <Null> 

0019             Stop Conversion Processing(”No data source was found for 

the archive environment”) 

0020          Else 

0021             Get and validate the data source for an environment / table  

(B98700) 

                        SL SourceEnvironment -> szEnvironment 

                        ”F42119” -> szTableName 

                        VA rpt_szPurgeDataSource_DATS <- szDataSource 

                        VA rpt_szErrorCode_DTAI <- szErrorDataItem 

                        VA rpt_mnErrorNumber_MATH01 <- mnErrorNumber 

0022             If VA rpt_szArchiveDataSource_DATS is equal to VA 

rpt_szPurgeDataSource_DATS 

0023                Stop Conversion Processing(”The source and archive 

environments have the same data source”) 

0024             Else 

0025                // 

0026                // Open a table with the same table name in the output 

environment. The table 

0027                // will be renamed later if the table name processing 

option was populated. 

0028                // 

0029                Copy Table Environment(”F42119”,  <None>, SL 

SourceEnvironment              , PO szArchiveEnvironmentName, <Yes>, <Yes>, 

<No>, <None>, <None>, <Null>, <Null>) 

0030                // 

0031                // Open a handle to the archive table 

0032                // 

0033                VA rpt_F42119Handle_HF42119 = F42119.Open Handle 

0034                If VA rpt_F42119Handle_HF42119 is equal to <Null> 

0035                   Stop Conversion Processing(”Failed to open F42119 in 

the archive environment”) 

  

0036                End If 

0037             End If 

0038          End If 

0039       End If 

0040    End If 

0041 End If 
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13. Using this example, the system writes log messages on Stop Conversion Processing 
to the JDE.log and JDEDEBUG.log files.  

14. After you have entered the begin process event rules, add the following variables:  

• FXXXXHandle_HFXXXX  

• szArchiveDataSource_DATS  

• szPurgeDataSource_DATS  

• szErrorCode_DTAI  

• cRenameFlag_EV01  

• mnErrorNumber_MATH01  

Make sure that you have mapped all parameters to a field, even if you will not use 
every value.  

15. On Selection for Batch Delete, choose Row Fetched and click Advanced ER. On 
Event Rules Design, enter the row fetched event rules, along with any special logic. 
Make sure that you have mapped all parameters to a field, even if you will not use 
every value. This example includes event rules for R42119P, as follows:  

0001 // 

0002 // If we are archiving the purged records, write the record to the 

archive table 

0003 // 

0004 If PO cArchiveRecords is equal to ”1” 

0005    F42119(VA rpt_F42119Handle_HF42119).Insert 

           IC Order Company (Order Number) -> TK Order Company (Order 

Number) 

           IC Document (Order No, Invoice, etc.) -> TK Document (Order No, 

Invoice, etc.) 

           IC Order Type -> TK Order Type 

           IC Line Number -> TK Line Number 

           IC Order Suffix -> TK Order Suffix 

           IC Business Unit -> TK Business Unit 

           IC Company -> TK Company 

           IC Document Company (Original Order) -> TK Document Company 

(Original Order) 

           IC Original Order Number -> TK Original Order Number 

           IC Original Order Type -> TK Original Order Type 

           IC Original Line Number -> TK Original Line Number 

           IC Company - Key (Related Order) -> TK Company - Key (Related 

Order) 

           IC Related PO/SO/WO Number -> TK Related PO/SO/WO Number 

           IC Related PO/SO/WO Order Type -> TK Related PO/SO/WO Order Type 
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           IC Related PO/SO Line Number -> TK Related PO/SO Line Number 

           IC Agreement Number - Distribution -> TK Agreement Number - 

Distribution 

           IC Agreement Supplement - Distribution -> TK Agreement Supplement 

- Distribution 

           IC Contract Balances Updated Y/N -> TK Contract Balances Updated 

Y/N 

           IC Address Number -> TK Address Number 

           IC Address Number - Ship To -> TK Address Number - Ship To 

           IC Address Number - Parent -> TK Address Number - Parent 

           IC Date - Requested -> TK Date - Requested 

           IC Date - Order/Transaction -> TK Date - Order/Transaction 

           IC Date - Scheduled Pick -> TK Date - Scheduled Pick 

           IC Date - Original Promised Delivery -> TK Date - Original 

Promised Delivery 

           IC Date - Actual Ship Date -> TK Date - Actual Ship Date 

           IC Date - Invoice -> TK Date - Invoice 

           IC Date - Cancel -> TK Date - Cancel 

           IC Date - For G/L (and Voucher) -> TK Date - For G/L (and 

Voucher) 

           IC Date - Promised Delivery -> TK Date - Promised Delivery 

           IC Date - Price Effective Date -> TK Date - Price Effective Date 

           IC Date - Promised Shipment -> TK Date - Promised Shipment 

           IC Date - Future Date 2 -> TK Date - Future Date 2 

           IC Reference -> TK Reference 

           IC Reference 2 -> TK Reference 2 

           IC Item Number - Short -> TK Item Number - Short 

           IC 2nd Item Number -> TK 2nd Item Number 

           IC 3rd Item Number -> TK 3rd Item Number 

           IC Location -> TK Location 

           IC Lot/Serial Number -> TK Lot/Serial Number 

           IC From Grade -> TK From Grade 

           IC Thru Grade -> TK Thru Grade 

 

           IC From Potency -> TK From Potency 

           IC Thru Potency -> TK Thru Potency 

           IC Days Before Expiration -> TK Days Before Expiration 

           IC Description -> TK Description 
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           IC Description - Line 2 -> TK Description - Line 2 

           IC Line Type -> TK Line Type 

           IC Status Code - Next -> TK Status Code - Next 

           IC Status Code - Last -> TK Status Code - Last 

           IC Business Unit - Header -> TK Business Unit - Header 

           IC Item Number - Related (Kit) -> TK Item Number - Related (Kit) 

           IC Kit Master Line Number -> TK Kit Master Line Number 

           IC Component Line Number -> TK Component Line Number 

           IC Related Kit Component -> TK Related Kit Component 

           IC Number of Component Per Parent -> TK Number of Component Per 

Parent 

           IC Sales Catalog Section -> TK Sales Catalog Section 

           IC Sub Section -> TK Sub Section 

           IC Sales Category Code 3 -> TK Sales Category Code 3 

           IC Sales Category Code 4 -> TK Sales Category Code 4 

           IC Sales Category Code 5 -> TK Sales Category Code 5 

           IC Commodity Class -> TK Commodity Class 

           IC Commodity Sub Class -> TK Commodity Sub Class 

           IC Supplier Rebate Code -> TK Supplier Rebate Code 

           IC Master Planning Family -> TK Master Planning Family 

           IC Purchasing Category Code 5 -> TK Purchasing Category Code 5 

           IC Unit of Measure as Input -> TK Unit of Measure as Input 

           IC Units - Order/Transaction Quantity -> TK Units - 

Order/Transaction Quantity 

           IC Quantity Shipped -> TK Quantity Shipped 

           IC Units - Qty Backordered/Held -> TK Units - Qty 

Backordered/Held 

           IC Units - Quantity Canceled/Scrapped -> TK Units - Quantity 

Canceled/Scrapped 

           IC Units - Future Quantity Committed -> TK Units - Future 

Quantity Committed 

           IC Units - Open -> TK Units - Open 

           IC Units - Shipped to Date -> TK Units - Shipped to Date 

           IC Units - Relieved -> TK Units - Relieved 

           IC Committed (H/S) -> TK Committed (H/S) 

           IC Other Quantity (1/2) -> TK Other Quantity (1/2) 

           IC Amount - Price per Unit -> TK Amount - Price per Unit 

           IC Amount - Extended Price -> TK Amount - Extended Price 
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           IC Amount - Open -> TK Amount - Open 

           IC Price Override Code -> TK Price Override Code 

           IC Temporary Price (Y/N) -> TK Temporary Price (Y/N) 

           IC Unit of Measure - Entered for Unit Price -> TK Unit of Measure 

- Entered for Unit Price 

           IC Amount - List Price -> TK Amount - List Price 

           IC Amount - Unit Cost -> TK Amount - Unit Cost 

           IC Amount - Extended Cost -> TK Amount - Extended Cost 

           IC Cost Override Code -> TK Cost Override Code 

           IC Extended Cost - Transfer -> TK Extended Cost - Transfer 

           IC Print Message -> TK Print Message 

           IC Payment Terms Code -> TK Payment Terms Code 

           IC Payment Instrument -> TK Payment Instrument 

           IC Based on Date -> TK Based on Date 

           IC Discount - Trade -> TK Discount - Trade 

           IC Trade Discount (Old) -> TK Trade Discount (Old) 

           IC Price and Adjustment Schedule -> TK Price and Adjustment 

Schedule 

  

           IC Item Price Group -> TK Item Price Group 

           IC Pricing Category Level -> TK Pricing Category Level 

           IC Discount Factor -> TK Discount Factor 

           IC Discount Factor Type - $ or % (D/P) -> TK Discount Factor Type 

- $ or % (D/P) 

           IC Discount Application Type -> TK Discount Application Type 

           IC Discount % - Cash -> TK Discount % - Cash 

           IC Document Company -> TK Document Company 

           IC Document (Voucher, Invoice, etc.) -> TK Document (Voucher, 

Invoice, etc.) 

           IC Document Type -> TK Document Type 

           IC Document - Original -> TK Document - Original 

           IC Document Type - Original -> TK Document Type - Original 

           IC Document Company - Original -> TK Document Company - Original 

           IC Pick Slip Number -> TK Pick Slip Number 

           IC Delivery Number -> TK Delivery Number 

           IC Number - Promotion Number -> TK Number - Promotion Number 

           IC Draft Number -> TK Draft Number 

           IC Sales Taxable (Y/N) -> TK Sales Taxable (Y/N) 
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           IC Tax Rate/Area -> TK Tax Rate/Area 

           IC Tax Expl Code 1 -> TK Tax Expl Code 1 

           IC Associated Text -> TK Associated Text 

           IC Priority - Processing -> TK Priority - Processing 

           IC Printed Code -> TK Printed Code 

           IC Backorders Allowed (Y/N) -> TK Backorders Allowed (Y/N) 

           IC Substitutes Allowed (Y/N) -> TK Substitutes Allowed (Y/N) 

           IC Partial Line Shipments Allowed (Y/N) -> TK Partial Line 

Shipments Allowed (Y/N) 

           IC Line of Business -> TK Line of Business 

           IC End Use -> TK End Use 

           IC Duty Status -> TK Duty Status 

           IC Commodity Code -> TK Commodity Code 

           IC Nature of Transaction -> TK Nature of Transaction 

           IC Primary / Last Supplier Number -> TK Primary / Last Supplier 

Number 

           IC Buyer Number -> TK Buyer Number 

           IC Carrier Number -> TK Carrier Number 

           IC Mode of Transport -> TK Mode of Transport 

           IC Conditions of Transport -> TK Conditions of Transport 

           IC Route Code -> TK Route Code 

           IC Stop Code -> TK Stop Code 

           IC Zone Number -> TK Zone Number 

           IC Container I.D. -> TK Container I.D. 

           IC Freight Handling Code -> TK Freight Handling Code 

           IC Apply Freight - Y/N -> TK Apply Freight - Y/N 

           IC AIA Document Flag -> TK AIA Document Flag 

           IC Freight Calculated (Y/N) -> TK Freight Calculated (Y/N) 

           IC Rate Code - Frieght/Misc -> TK Rate Code - Frieght/Misc 

           IC Rate Type - Freight/Misc -> TK Rate Type - Freight/Misc 

           IC Shipping Commodity Class -> TK Shipping Commodity Class 

           IC Shipping Conditions Code -> TK Shipping Conditions Code 

           IC Serial Number - Lot -> TK Serial Number - Lot 

           IC Unit of Measure - Primary -> TK Unit of Measure - Primary 

           IC Units - Primary Quantity Ordered -> TK Units - Primary 

Quantity Ordered 

           IC Unit of Measure - Secondary -> TK Unit of Measure - Secondary 
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           IC Units - Secondary Quantity Ordered -> TK Units - Secondary 

Quantity Ordered 

           IC Unit of Measure - Pricing -> TK Unit of Measure - Pricing 

           IC Unit Weight -> TK Unit Weight 

           IC Weight Unit of Measure -> TK Weight Unit of Measure 

           IC Unit Volume -> TK Unit Volume 

           IC Volume Unit of Measure -> TK Volume Unit of Measure 

           IC Reprice (Basket Price) Category -> TK Reprice (Basket Price) 

Category 

           IC Order Reprice Category -> TK Order Reprice Category 

           IC Order Repriced Indicator -> TK Order Repriced Indicator 

           IC Costing Method - Inventory -> TK Costing Method - Inventory 

           IC Commitment Method -> TK Commitment Method 

           IC G/L Offset -> TK G/L Offset 

           IC Century -> TK Century 

           IC Fiscal Year -> TK Fiscal Year 

           IC Line Status -> TK Line Status 

           IC Inter Branch Sales -> TK Inter Branch Sales 

           IC On Hand Updated -> TK On Hand Updated 

           IC Configurator Print Flag -> TK Configurator Print Flag 

           IC Sales Order Status 04 -> TK Sales Order Status 04 

           IC Substitute Item Indicator -> TK Substitute Item Indicator 

           IC Preference Commitment Indicator -> TK Preference Commitment 

Indicator 

           IC Ship date (PDDJ) overridden -> TK Ship date (PDDJ) overridden 

           IC Price Adjustment Line Indicator -> TK Price Adjustment Line 

Indicator 

           IC Price Adj. History Indicator -> TK Price Adj. History 

Indicator 

           IC Preference Production Allocation -> TK Preference Production 

Allocation 

           IC Transfer/Direct Ship/Intercompany Flag -> TK Transfer/Direct 

Ship/Intercompany Flag 

           IC Deferred entries flag -> TK Deferred entries flag 

           IC Euro Conversion Status Flag -> TK Euro Conversion Status Flag 

           IC Sales Order Status 14 -> TK Sales Order Status 14 

           IC Sales Order Status 15 -> TK Sales Order Status 15 

           IC Salesperson 01 -> TK Salesperson 01 

           IC Salesperson Commission 001 -> TK Salesperson Commission 001 
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           IC Salesperson 02 -> TK Salesperson 02 

           IC Salesperson Commission 002 -> TK Salesperson Commission 002 

           IC Apply Commission (Y/N) -> TK Apply Commission (Y/N) 

           IC Commission Category -> TK Commission Category 

           IC Reason Code -> TK Reason Code 

           IC Gross Weight -> TK Gross Weight 

           IC Gross Weight Unit of Measure -> TK Gross Weight Unit of 

Measure 

           IC Account Number - Input (Mode Unknown) -> TK Account Number - 

Input (Mode Unknown) 

           IC Account ID -> TK Account ID 

           IC Project Business Unit -> TK Project Business Unit 

           IC Object Account -> TK Object Account 

           IC Subsidiary -> TK Subsidiary 

           IC Ledger Type -> TK Ledger Type 

           IC Subledger - G/L -> TK Subledger - G/L 

           IC Subledger Type -> TK Subledger Type 

           IC Code - Location Tax Status -> TK Code - Location Tax Status 

           IC Price Code 1 -> TK Price Code 1 

           IC Price Code 2 -> TK Price Code 2 

           IC Price Code 3 -> TK Price Code 3 

           IC Status - In Warehouse -> TK Status - In Warehouse 

           IC Work Order Freeze Code -> TK Work Order Freeze Code 

           IC Send Method -> TK Send Method 

           IC Currency Code - From -> TK Currency Code - From 

           IC Currency Conversion Rate - Spot Rate -> TK Currency Conversion 

Rate - Spot Rate 

           IC Amount - List Price per Unit -> TK Amount - List Price per 

Unit 

           IC Amount - Foreign Price per Unit -> TK Amount - Foreign Price 

per Unit 

           IC Amount - Foreign Extended Price -> TK Amount - Foreign 

Extended Price 

           IC Amount - Foreign Unit Cost -> TK Amount - Foreign Unit Cost 

           IC Amount - Foreign Extended Cost -> TK Amount - Foreign Extended 

Cost 

           IC User Reserved Code -> TK User Reserved Code 

           IC User Reserved Date -> TK User Reserved Date 

           IC User Reserved Amount -> TK User Reserved Amount 
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           IC User Reserved Number -> TK User Reserved Number 

           IC User Reserved Reference -> TK User Reserved Reference 

           IC Transaction Originator -> TK Transaction Originator 

           IC User ID -> TK User ID 

           IC Program ID -> TK Program ID 

           IC Work Station ID -> TK Work Station ID 

           IC Date - Updated -> TK Date - Updated 

           IC Time of Day -> TK Time of Day 

0006 // 

0007 // Do not delete the record if the insert to the archive table failed. 

0008 // 

0009 If SV Error_Status is not equal to CO ERROR 

0010  Delete Current Input Row 

0011 End If 

0012 Else 

0013  Delete Current Input Row 

0014 End If 

 

16. On Selection for Batch Delete, choose Process End and click Advanced ER. On 
Event Rules Design, enter the process end event rules, along with any special logic. 
Ensure that you have mapped all parameters to a field, even if you will not use every 
value. For this example, use event rules for R42119P, as follows:  

0001 If PO cArchiveRecords is equal to ”1” 

0002    // 

0003    // Close the table 

0004    // 

0005    F42119(VA rpt_F42119Handle_HF42119).Close 

0006    // 

0007    // If the data was archived and the table name processing option was 

populated, 

0008    // rename the table. 

0009    // 

0010    If PO szArchiveTableName is not equal to <Blank> 

        And PO szArchiveTableName is not equal to <Null> 

0011       Rename Table   (B0000202) 

              ”F42119” -> szOldTableName 

              PO szArchiveTableName -> szNewTableName 
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              ”<Blank>” -> szTableOwnerID 

              ”<Blank>” -> szPassword 

              VA rpt_szArchiveDataSource_DATS -> szDataSource 

              VA rpt_cRenameFlag_EV01 <- cRenameTableSuccessful 

0012    End If 

0013 End If 

 

See Also 
� Using a Handles in the Development Tools Guide for instructions on creating and 

using handles 

� Batch Delete in the Table Conversion Guide for information about currency triggers 
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Reviewing Your Table Conversion  

To review your table conversion after you create it, use the Table Conversion Mapping and 
Properties forms, which display simultaneously when you complete or view a table 
conversion. These forms present the same options as the Director.  

You also can review processing options, data structures, data sequencing, and data selection 
by choosing them from the Conversion menu from the menu bar. Each tab works as the 
forms in the Table Conversion Director do.  

 

► To review your table conversion  

The Table Conversion View menu appears. 

1. Choose Table Conversion Properties. 

2. On Table Conversion Properties, review and modify your table conversion.  

3. When you are satisfied with your table conversion, click OK.  

4. Click the Save button.  

5. From the File menu, choose Exit.  
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Using Event Rules in a Table Conversion 

You can use event rules to build complex functional capabilities into table conversions. For 
example, you can use event rules to insert information into a table or delete one or more rows 
in a table based on certain conditions.  

You attach event rules to a particular event, such as Process Begin, Row Fetched, Format 
Fetched, and Process End. 

Event rules in table conversion include system functions that are specific to the table 
conversion tool.  

See Also 
� The Flow of Events in Table Conversion in the Table Conversion Guide for more 

information about table conversion events 

� Table Conversion System Functions in the Table Conversion Guide for a list of 
system functions and an explanation of each 

 

► To use event rules in a table conversion  

A form with an Advanced ER button appears. 

1. Choose the event to which you want to add event rules from the Events drop-down 
list.  

2. Click the Advanced ER button.  

3. On Event Rules Design, choose any of the following buttons to define specific 
business logic: 

• Assignment 

Defines a field as a fixed value or a mathematical expression. For example, you 
can create an assignment that calculates a value rather than writing a business 
function to calculate it.  

• If/While 

Creates If and While logic statements, which are conditional instructions for an 
event rule.  

• Business Function 

Attaches an existing business function, such as a function that retrieves a next 
number for a new customer or a function that converts Julian dates to month, 
day, and year.  

• System Function 

Attaches an existing J.D. Edwards system function, such as Copy Table 
Environment or User Insert Row.  
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• Variables 

Attaches variables to accumulate totals, attaches variables that conditionally 
control what you write to a file, keeps a tally of the number of records you read in, 
and so on.  

• Else 

Creates Else logic statements. When you create an If statement, an Else 
statement is automatically inserted after the If statement.  

• Table I/O 

Allows you to open tables in the input, output, or login environment, and also 
allows you to open the same table twice. It also allows you to pull in data from 
tables other than the input table and use data from those tables to create an 
output record. For example, you might want to set up a table conversion that 
loops through records in F0101 (Address Book Master) and copies them to 
another table, and then loops back through the records, finds each customer that 
has a certain employee as a contact, and copies that information to the output 
table as well.  

• Report Interconnect 

Connects a batch process or report to the table conversion.  

4. After defining your event rules, click OK.  

5. Repeat steps as necessary for the different input and output formats.  

See Also 
� Table Conversion System Functions in the Table Conversion Guide for more on 

system functions  

� Table I/O in the Development Tools Guide 

Table Conversion System Functions  

Each system function within event rules that you can use within a table conversion is 
explained below:  

CopyTableDataSource  Use this system function to copy a table or range of tables from one data 
source to another. The system copies tables based on specifications in the 
login environment.  

CopyTableEnvironment  Use this system function to copy a table or range of tables from one 
environment to another. The system copies tables based on specifications 
in the input and output environments. If the specifications differ, the 
system performs a "map and drop," which means that it creates a mapping 
between like fields in the source and destination tables, and ignores all 
other fields.  

TCInsertRow  The table conversion system inserts this system function when you 
choose the Issue a write for this event? option and it cannot be moved. 
This function instructs the system that data should be written to the output 
table.  

62 



UserInsertRow  Use this system function to specify when and where a row should be 
inserted into the specified output table.  

DeleteCurrentInputRow  Use this system function to delete the current record from the input table.  

UpdateCurrentInputRow  Use this system function to update the current record in the input table 
after it has been changed.  

SetSelectionAppendFlag Use this system function to determine whether selection criteria added by 
the system function SetUserSelection will append or replace the existing 
selection criteria on the input table.  

SetUserSelection  Use this system function to conditionally modify data selection on the input 
table. Call SetSelectionAppendFlag before calling SetUserSelection to 
determine whether to replace or append the existing data selection 
information on the input table.  

See Also  
� Event Rules Design in the Development Tools Guide for more information about 

event rules  
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Running a Table Conversion  

When you run a table conversion, you submit it using a batch version. To track what happens 
during the conversion process, you can turn on tracing, which writes the details of what 
happened during the conversion to a log. You can set the trace level to control the detail of 
the log information. When you test a table conversion, you can designate that the conversion 
proceed one row at a time, which can help you isolate problems or unexpected results. 
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Submitting a Table Conversion  

After you create your table conversion, you submit it using a batch version. When you submit 
the batch version, you can prompt the system to override the properties, such as input and 
output environment or trace level, and override the location at which your table conversion 
will process.  

If you are using the Web client, you can also submit a table conversion, but you cannot 
override any properties except processing options, location, and job queue. 

 

► To override the table conversion properties 

From the System Administration Tools (GH9011) menu, choose Batch Versions. 

Note 

If you click Cancel while overriding the properties, J.D. Edwards software will not save your 
changes to the version. To change the properties of the version without running it, on Work 
With Batch Versions, choose Properties from the Row menu. 

  

1. On Work With Batch Versions, complete the following field and click Find: 

• Batch Application 

2. Highlight a version and click Select. 

3. On Table Conversion Prompting, choose the Properties option and click Submit.  

Note 
If you are using a Web client, you cannot choose the Properties option, you can only 
choose and change Processing Options. 

 

4. On the Properties form, review and override the environments, table options, data 
selection, and logging options that you specified within the conversion. 

You can edit these options the same way as when you set up the table conversion. 
Basically, the forms are the same.  

5. To turn on debug logging, click the Debug Logging tab and do the following:  

• To use the jde.ini settings for the trace level and row-by-row conversion process, 
make sure that the Use ini settings for trace level and number of rows to process 
option is turned on. The system will use only the settings contained in your jde.ini 
file and will override any values that you enter in the Trace Level and Number of 
Rows fields described below.  

• To override the trace level in the jde.ini file, turn off the Use ini settings for trace 
level and number of rows to process option. Enter a number from 0 to 10 in the 
Trace Level field.  
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• To convert a specific number of records (for example, if you want to test the table 
conversion), turn off the Use ini settings for trace level and number of rows to 
process option. Enter the number of rows that you want to convert in the Number 
of Rows field. If you enter 0 for this value, the system processes all rows.  

This option corresponds to the StopAfterRow setting in the jde.ini file. If you enter 
a value here, you will override any specifications you added to the jde.ini file.  

6. Click OK to save your changes to the version. 

The system submits the table conversion.  

See Also 
� Testing a Table Conversion in the Table Conversion Guide for more information 

about StopAfterRow   

 

► To override the table conversion location 

You can override the location where you want to process your table conversion if, for 
example, the server that you normally use is inoperable.  

From the System Administration Tools menu (GH9011), choose Batch Versions. 

1. On Work With Batch Versions, choose the version and click Select.  

2. On Table Conversion Prompting, turn on the Override Location option and click 
Submit.  

3. On JDE Data Sources, choose the data source that you want to use as your override 
location and click Select.  
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Testing a Table Conversion  

You might want to test a table conversion to ensure that it has no errors. To do this, you can 
log debug information about the conversion while it runs. You also can force the conversion 
to run one row at a time, which is useful if the conversion normally runs as an insert-from-
select.  

To log debug information about a table conversion, enable tracing and set a trace level from 
0 to 10 in the jde.ini file according to how specific you want the logged information to be.  

You set debug logging in the jde.ini file; if necessary, you can override the jde.ini settings 
through the version of a conversion. 

If you set the trace level for logging at 1, the system logs basic information about the table 
conversion, such as name, inputs, outputs, event rule logic, and how many rows were 
inserted. If you set the trace level at 10, the system logs all information about every column in 
every format, including user-defined formats, whether a processing option template is 
associated with the table conversion, and all other information involved in the table 
conversion process. The higher you set the trace level, the more information the system will 
supply about the table conversion process.  

When you test a table conversion, you might want to force a row-by-row conversion. You also 
might want to set a trace level on your workstation or on the server, depending on where you 
want to run the conversion.  

The Difference Between Logging Options and Debug Logging  

Logging options, which you specify when you set up a conversion, can log all errors that 
occur during the conversion or can log all records that are copied, deleted, or updated. They 
also can log the details of copy table actions.  

Debug logging can log more detailed information about the conversion. This information can 
help you pinpoint the exact area in the conversion where errors occurred.  

Note 

Debug logging changes that you make to the version will override the settings in the jde.ini 
file. 

 

Trace Levels  

The following information is specific to each trace level:  

Trace Level  Logging Information  

Level 1  Logs general information about the conversion, such as name, inputs, outputs, event rule 
logic, and how many rows were inserted.  

Level 2  Logs function call traces, such as starting conversion, ending conversion, and inserting 
rows.  
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Level 3  Logs the points at which event rules are executed.  

Level 4  Not applicable.  

Level 5  Logs the points at which jdeCallObject is executed, such as calls to business functions 
from event rules.  

Levels 6-8  Not applicable.  

Level 9  Logs the content of columns during input, event rules, and before output.  

Level 10  Logs all information contained in the first nine levels.  

 

Caution 

J. D. Edwards recommends that you do not set your trace level at 10 when running a table 
conversion over tables that contain a large amount of data. The system will write a large 
amount of data onto your server, which could cause it to run out of disk space. You can, 
however, specify a certain number of rows to run in the version of the table conversion by 
choosing the Properties option. 

 

 

Setting the Trace Level for Debug Logging  

You can set a trace level for debug logging on a workstation or on a server, depending on 
where you are running the conversion.  

 

► To enable tracing and set the trace level on a workstation 

1. Open the jde.ini file on the workstation. 

2. To enable tracing and to set the trace level on a workstation, add the following:  
[TCEngine]  

TraceLevel=n  

(Where n is a number from 0 through 10.)  

[Debug]  

Output=File  

[UBE]  

UBESaveLogFile=1  
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► To enable tracing and set the trace level on a server 

1. Open the jde.ini file on the server. 

2. To enable tracing and to set the trace level on a server, add the following:  
[TCEngine]  

TraceLevel=n  

(Where n is a number from 0 through 10.)  

[Debug]  

Output=File  

KeepLogs=1  

Forcing Row-By-Row Conversion 

You can set the system to force a row-by-row conversion when you want to test your table 
conversion. You can force row-by-row on your workstation or the server. You can also specify 
a certain number of rows to process in conjunction with forcing a row-by-row conversion.  

 

► To force row-by-row conversion  

1. Open the jde.ini file. 

2. Add the following to the jde.ini file:  
[TCEngine]  

ForceRowByRow=1  

 

► To specify the number of rows to process  

1. Open the jde.ini file. 

2. In the jde.ini file beneath the [TCEngine] header, add the following: 

StopAfterRow=n  

(Where n is the number of rows you want to process.)  
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Preparing Non-J.D. Edwards Software Tables for Table 
Conversion  

Non-J.D. Edwards software tables are text files, or any other file or database, that are not 
recognized by J.D. Edwards software but the database is a type supported by J.D. Edwards 
software, Oracle, Access, AS/400, or SQL Server.  

Before you can work with non-J.D. Edwards software tables in the table conversion tool, you 
need to make them known to J.D. Edwards software. To do this, you must set up an ODBC 
data source for the foreign tables, and then set up a data source, environment, and OCM 
mapping in J.D. Edwards software that points to the ODBC data source.  

Note  

When you work with foreign tables, your database administrator needs to address database 
authority issues. Your J.D. Edwards software user ID (or, if you are using the J.D. Edwards 
software security server feature, the database user to which it maps) must be changed so 
that you will have authority to use the tables in the foreign database. Without this authority, 
you will not be able to see the tables in the design tool. Under certain conditions, the table 
conversion engine will need to create temporary tables in the output environment and will 
require create-and-drop authority for the database. 
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Adding a J.D. Edwards Software Data Source 

Before you can add a J.D. Edwards software data source for a foreign table, you must first 
add a Microsoft ODBC data source or an Oracle OCI data source that points to the foreign 
table. For complete information about ODBC drivers and data sources, consult the 
appropriate Microsoft or Oracle documentation.  

After you have added an ODBC or Oracle data source, you need to add a data source in 
J.D. Edwards software that points to the data source that you just set up.  

 

► To add a J.D. Edwards software data source  

From the System Administration Tools menu (GH9011), choose Database Data Sources. 

1. On the Machine Search & Select form, highlight the machine on which the data 
source resides and click Select. 

2. On Work With Data Sources, click Add.  

3. On Data Source Revisions, complete the following fields and click OK:  

• Data Source Name  

The data source name can be different from the ODBC or Oracle database 
name, if necessary.  

• Data Source Use 

Enter DB in this field to identify the data source as a database data source. You 
use only database data sources when accessing data in tables.  

• Platform 

• Logical Server Name 

• Server Map Data Source Name 

4. Click OK.  
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Adding a J.D. Edwards Software Environment  

For each ODBC data source, database instance, or library that contains non-J.D. Edwards 
software tables, you must set up an environment. The environment points to the J.D. 
Edwards software data source, which in turn points to the database or library. The easiest 
way to add an environment is to copy an existing one.  

 

► To add a J.D. Edwards software environment  

From the Environments menu (GH9053), choose Environment Master. 

1. On Work With Environments, find and highlight the environment that most closely 
matches the environment that you want to add (such as the environment you are 
logged in to or any other environment you can access from your workstation), and 
then choose Copy Environment from the Row menu.  

2. On Copy Environment, type an environment name in the New Environment field.  

3. To copy only the *PUBLIC Object Configuration Manager mappings of an 
environment, turn on the Copy *PUBLIC Records Only option.  

Leave this option turned off to copy mappings for the environment, individual users, 
and *PUBLIC.  

4. Click OK.  

See Also  
� Working with an Environment in the Configurable Network Computing 

Implementation Guide for more information about adding environments  
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Setting up a Default OCM Mapping  

You map objects, such as tables, by environment. When you set up a default OCM mapping, 
you choose an environment that you have already created and map that environment's 
objects to the data sources where those objects exist. 

You create a default map for a TBLE object type. You create a mapping of an object name 
with a literal value of DEFAULT, and then enter an object type (TBLE) and a data source. 
When you create a default map for the object type TBLE, any table objects not mapped 
individually will point to the default data source. In addition, the table conversion tool will use 
this mapping for foreign tables.  

Each environment must have a default map for table objects for the *PUBLIC user profile 
because no inherent default location exists for table objects. If table objects do not have a 
default map and are not explicitly mapped by name, J.D. Edwards software produces a 
Select/Failed error message when it tries to access the tables. Additionally, the tables will not 
appear in the input or output forms in the Table Conversion Design application.  

 

► To set up a default OCM mapping  

From the System Administration Tools menu (GH9011), choose Object Configuration 
Manager.  

1. On Machine Search and Select, choose the data source that stores the Object 
Configuration Manager table with which you want to work, and click Select.  

2. On Work With Object Mappings, click Add. 

The Object Mapping Revisions form appears. On this form, you determine to what 
data source your table will map.  

3. Enter the following information: 

• Environment Name 

• Object Name 

Enter DEFAULT in this field.  

• Primary Data Source 

The primary data source refers to the location within the environment of the 
object for which you will create a mapping. Enter the data source name that you 
set up for your foreign tables.  

• User 

The user is the individual or group for whom the mapping applies. You normally 
enter *PUBLIC in this field.  
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• Data Source Mode 

Enter P in this field. P stands for primary.  

• Allow QBE 

You can use this field to indicate whether applications based on the table include 
a Query By Example line.  

4. Click OK to save your object mapping.  

The system displays the mapping that you created with an inactive status.  

5. Change the status to active.  

You can now access the tables in this data source as foreign tables by using this 
environment in your table conversion.  

See Also  
� Working with the Object Configuration Manager in the Configurable Network 

Computing Implementation Guide for more information about J.D. Edwards software 
environments, data sources, and OCM mapping  

� Understanding Data Sources and Working with the Object Configuration Manager in 
the Configurable Network Computing Implementation Guide for more information 
about data sources 


